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Overview

This guide describes how the Senturus Analytics Connector is used from Power Bl after it has
been configured.

Please refer to the Senturus Analytics Connector Installation and Configuration Guide for
instructions on installing and configuring the Analytics Connector.

The Analytics Connector is designed for Power Bl and has been tested against different versions,
including both Power Bl Desktop and Power Bl Gateway on Windows starting with the August
2018 release. For optimal stability and performance, it is recommended that you keep your Power
Bl software fully updated.



Data Connector vs SQL Server Database Connection

Starting from version 5.0, you can connect from Power Bl Desktop and Power Bl Gateway to
Analytics Connector via SQL Server database connection.

If you migrated from version 4.x, you may still use our custom Data Connector to connect, all your
old reports and data sources will continue working. And you can still use our custom Data
Connector in new reports if you wish.

Comparing to custom Data Connector, using SQL Server database connection gives you following
advantages:

1. No need to install Analytics Connector ODBC client.
2. No need to copy custom Data Connector (.mez files).

3. Use Windows authentication from Power Bl Desktop to Analytics Connector server to
Cognos.!

4. More Power Bl functions are supported, e.g. guery cancellation.

But there is a known issue when using SQL Server database connection to connect to Analytics
Connector, you cannot filter decimal columns. This issue will be fixed in later releases.

Our custom Data Connector wraps Analytics Connector ODBC client and enables DirectQuery
capabilities.

To use custom Data Connector, follow steps below:

1. Install Senturus Analytics Connector ODBC client. The latest ODBC client can be found at
Senturus Analytics Connector - Customer Resources.?

2. Copy the Custom Data Connector “SenturusAnalyticsConnector.mez” from Analytics
Connector server (under “<install_root>\Power BI” folder) to you Power Bl Desktop computer
(under “{Userf\Documents\Power Bl Desktop\Custom Connectors” folder).

If your Senturus Analytics Connector server administrators made some changes using
Senturus Data Source Configuration tool or Service Configuration tool, for example mapped a
new database to a Cognos package, or moved Analytics Connector server to a new host, a
new “SenturusAnalyticsConnector.mez” file will be generated and you need to copy it again.

1 Both Power Bl Desktop and Cognos server must be secured by the same Active Directory service.

2 ODBC client is automatically installed when you are installing Senturus Analytics Connector server. So, you
don’t have to install ODBC client separately on the same computer.


https://powerbi.microsoft.com/en-us/blog/tag/query-cancellation/
https://www.senturus.net/connector-download/

3. Start Power Bl Desktop, go to Files -> Options and Settings -> Options, select Security on left
panel, and under “Data Extensions” option, check “(Not Recommended) Allow any
extensions to load without validation or warning.” You need to restart Power Bl Desktop.



Connecting to Analytics Connector Server from Power Bl Desktop

You don’t connect to Cognos directly from Power Bl Desktop or Power Bl Gateway. Instead you
connect to Analytics Connector server and Analytics Connector server connects to Cognos
dispatcher on your behalf. For more information, please refer to “Senturus Analytics Connector
Installation Guide”, section Architecture Overview.

As mentioned before, you can connect to Analytics Connector Server using either Power Bl built-in
SQL Server database connector, or Senturus custom Data Connector.

Conecting via SQL Server database connector

To begin, open Power Bl Desktop and select Get Data -> SQL Server from the ribbon. “SQL
Server database” dialog pops up.

In Server input box, Type in hostname of IP of Analytics Connector server.

In Database (optional) input box, type in database name given by your Analytics Connector
administrator when he/she mapped a Cognos package or data module to it. Please note, Database
is mendentary in this case.

Check DirectQuery and (optionally) check “Navigate using full hierarchy”.
Then click on OK button.

SQL Server database

Server (1)
winl3.example.com
Database (opticnal)

GO Sales (query)

Data Connectivity mode (0
O Import

® DirectQuery

4 Advanced options

Command timeout in minutes {optional)

SQL statement (optional, requires database)

O Include relationship columns
¥ Mavigate using full hierarchy
[ Enzble SOL Server Failover support

& [ ]



You can use either Windows authentication or Database authentication (by providing your
Cognos login user name and password).

SQL Server database X
Windows win03.example.com;GO Sales (query)

User name

Database
cognos

Microsoft account Password

sessssne

Select which level to apply these settings to

win(3.example.com;GO Sales (query) -

o

NOTE: Power Bl desktop will securely store these credentials and skip this dialog if you have
entered before.

To manage or delete the stored authentication information, go to File 2 Options and settings 2>
Data source settings.

You may see a warning popup if SSL is not enabled on Analytics Connector server. Click OK to
dismiss this message.

Encryption Support
We were unable to connect to the data source using an encrypted

connection. To access this data source using an unencrypted
connection, click QK.

If your database is mapped from Cognos package, you will see following objects in Navifator panel:

1. Each namespace is mapped to a schema. Plus some system schemas as you will see
when connecting to a real SQL server database.

2. Each query subject is mapped to a table.

3. Each query item will be mapped to a column. Plus a dummy column AAA_LINK in each
mapped table. See Creating Relationships regarding more informaton.

4. If you have standalone calculations under a namespace, each calculation is mapped to a
column under a special table AAA_CALCULATIONS (table name is configurable in Data
Source Configuration tool). You can use this special table same as other query subject
mapped tables.



5. If you configured schema to report folder mappings, each report will be mapped to a table
under a schema. However, you cannot use report mapped tables as regular tables, please
refer to Working with Reports for more information.

If your database is mapped from Cognos data module, you will see following objects in Navifator
panel:

1. Only one schema with the same name as your data module. Plus some system schemas
as you will see when connecting to a real SQL server database.

2. Each table in data module is mapped to a SQL Server database table.

3. If you configured schema to report folder mappings, each report will be mapped to a table
under a schema. However, you cannot use report mapped tables as regular tables, please
refer to Working with Reports for more information.

Select only tables you need to pull columns from and click on Load button.

Hint, you don’t have to wait table preview to be loaded before clicking on Load button, and you can
uncheck Display Options -> Enable data previews option to skip previews.

o X
Navigator
e Products &
Display Options ~ DZ AAA_LINK Product line code Product line Product type cod
b Returmt Only selected items 1 994 Outdoor Pratection
. ~ e ~
b root Enable data previews 2 581 Camping Equipment
3 583 Personal Accessories
4 Sales (query) [15] 4 993 Personal
v [E| Branch 5 593 Personal
O CALCULATIONS 6 993 Personal Accessori
[m] [El Order 7 583 Personal Accessories
4 Out, cti
o [EI Order method a8 584 Qutdoor Protection
9 591 Camping Equipment
[m] [E| Parameterized Products o
10 891 Camping Equipment
[m] E Parameterized Products 2 11 954 Outdoor Protection
v [E| Products 12 5994 Outdoor Protection
O Retailer type 13 594 Qutdoor Protection
. a | ou .
] E Retailers 14 584 Qutdoor Protection
15 584 Qutdoor Protection
v [E| Sales
16 591 Camping Equipment
u| [EI Sales staff 17 591 Camping Equipment
v [E| Time 18 581 Camping Equipment
[m] [ﬁ Time (close date) 19 591 Camping Equipment
[m] [El Time (ship date) 20 8995 Golf Equipment
21 554 Qutdoor Protection
[m] E User
22 995 Golf Eguipment
4 Sales target (queny) v 23 583 Personal Accessories N
[ sys < >
Select Related Tables Load Transform Data | | Cancel |




Power BI will then inspect the selected tables and load them into report.
*

Apply query changes

Cancel

After loading tables into Power BI, you need to create relationships among tables before building
report pages. Please refer to Creating Relationships for more information.



Connect via Data Connector

To begin, open Power Bl Desktop and select Get Data.
Find the Senturus Analytics Connector in the list.

Click Connect.

Get Data

Senturus x All

‘% Senturus Analytics Connector

All
Other

Certified Connectors Connect Cancel

Power BI will display a dialog where you can select the Server, Port, Database, and Data
Connectivity modes.

The Server, Port and Database lists are pulled from the configuration information in the
DataSourceConfig.xml file under the server’s Analytics Connector installation folder.

For the Data Connectivity mode, select DirectQuery.

Click OK.

Senturus Analytics Connector

Server
Port

Database

Data Connectivity mode (i
Import

® DirectQuery

oK Cancel




An authentication dialog will appear. Type in your Cognos credentials, then click Connect.

Senturus Analytics Connector X

< Senturus Analytics Connector

User name

Password

Back Connect Cancel

NOTE: Power Bl desktop will securely store these credentials and skip this dialog if you select the
same Server and Database in a future connection.

To manage or delete the stored authentication information, go to File - Options and settings 2>
Data source settings.

Once connected to the Senturus Analytics Connector data source, the Navigator window will
display.

Select the tables you wish to include.

Click Load.

o X
Navigator
P Branch &
Display Options D&' Preview downloaded on Thursday, October 4, 2018
P Cognos_Senturus: GO Sales (query) [1] _LINK_COLUMM_  Branch code Address 1 Address 1 (multis
1 6|75, rue du Faubourg St-Honoré 75, rue du Fau
4 GO Sales (query) [11]
2 7 Piazza Duomo, 1 Piazza Duomo
C tor Report
b onnector Reports 3 9 Singelgravenplein 4 singelgravenp
4 Filters and calculations 4 13|Schwabentor 35 Schwabentor
I Inventory (query) 5 14 LeopoldstraBe 36 Leopoldstraiie
b nsl 6 15 Isafjordsgatan 30 C Isafjordsgatan
I ns2 7 17 7800, 756 - 6th Avenue. S.W. 7800, 756 - 6tl
] 18|789 Yonge Strest 789 Yonge 5tn
I Product forecast (query)
Ll 191288 Dorchester Avenue 1288 Dorchesl
b [ Retumed items (query) 10 20 299 Yale Avenue 299 Yale Aven
[ root 11 21 1288 South Barrington Ave. 1288 South Ba
477 Sales [queny) [14] 12 22 10032 NW 186th 10032 NW 18¢
) AAA_CALCULATIONS 13 23 6c, rue de I'Eglise &c, rue de I'Egf
14 24 Prol. Paseo de la Reforma No. 51 Prol. Paseo de
¥ B Branch
15 25/202-2-3 Hyzkunincho 202-2-3 5 A0
& Order 16 26 543-225 Asahi 543-225 18
[ Order methad 17 28 2315 Queen's Ave 2315 Queen's
E Parameterized Products 12 29 Plaza de |a Constitucion, 5/n Plaza de la Cot
I Parameterized Products 2 19 30 Avenida Paulista, 333 Avenida Paulis
20 31 Kauppakatu 33 Kauppakatu 3;
¥ [ Products —
21 32 234-12, Kongdeok-Dong LTEE 73410
B Retailer type v 22 3310 Claymore Hill e 10! Y
[ Retailers < >
Load Edit Cancel




Power BI will then inspect the selected tables for column information.
x

Apply query changes

Cancel

When complete, navigate to the Relationships view and creaste relationships among tables.



Creating Relationships

Power Bl requires relationships between the tables, but Cognos typically does not present primary
key and foreign keys at the business user view.

The Analytics Connector injects AAA_LINK columns into the tables so you can build relationships
between the tables. The Analytics Connector ignores these columns when passing queries to
Cognos to execute.

NOTE: It is very important that you create the relationships as described so that Power Bl sends
the appropriate queries to Cognos!

Start by dragging the AAA_LINK column in the fact table to the AAA_LINK table in the dimension
table.

[l

B8
m Branch o o Sales o ﬁ Time e

3 AAA_LINK < T AAA_LINK } T AAA_LINK
Address 1 2 Gross profit Date
Address 1 (multiscript) Z Planned revenue z Day key
Address 2 Z Product cost z Day of the month
Address 2 (multiscript) Z Quantity Z Day of the week

Z Branch code E Revenue z Day of the year

- - Collapse ™
Collapse P

Collapse

3

m Products

3 AAA LINK

¥ Base product number
Discontinued date
ntroduction date
Product

-~

Collapse

In the Create Relationship dialog, make sure the cardinality is set Many to one (*:1).
Change the Cross filter direction to Both.

Check the box next to Assume referential integrity.

Click OK.

Hint: You don’t have to wait Power BI to populate preview contents before clicking OK button. And
if Power Bl pops up an error dialog because it does not finish probing two tables yet, you can



simply dismiss and ignore that error, as Power Bl will create relationships as you specified anyway.

X
Create relationship
Select tables and columns that are related.
Sales -
AAA_LINK Quantity Unit cost Unit price Unit sale price Revenue Product cost Gross profit Pl
1 146 4045 85 85 12410 5505.7 6504 .3
2 a8 4273 85.3 85.3 7144 341.84 37256
3 23 41.36 73 73 1673 951.28 Fari2
< >
Eranch -
AAA_LINK Branch code Address 1 Address 1 {multiscript) Address 2 Address 2 {multiscript) City
1 40 55 Rue Rothschild 55 Rue Rothschild null null | Gené
2 39 ledleser StraBe 7 Jedleser Strafie 7 null null Wien
3 38 Interleuvenlaan 2 Interleuvenlaan 2 null null Hever
£ >
Cardinality Cross filter direction
Many to one (1) T Both -
¥ Make this relationship active Apply security filter in both directions
¥ Assume referential integrity Learn more
oK Cancel

Repeat these steps until the fact table has relationships to all dimension tables.



If you have multiple fact tables, chain these fact tables based on granularity and link the highest
level fact table to dimension tables, as shown in the diagram below.

&8

9

ﬁ Sales

AAA_LINK
Gross profit
Planned revenue

Product cost

A MM

e,

Collapse

i

TN‘. Branch

AAALINK

Address 1

Address 1 [multiscript)
Address 2

Address 2 (multiscript)
Branch code

City

Collapse ™

After creating relationships,

D)

0T

1
TTJ‘. Sales target

ALA_LINK * TS
Y Sales target

9

h 4

Collapse -

)

9

?ﬂ Products

AAL LINK

Base product number
Discontinued date
ntroduction date

Product

Collapse ™

change to the Report view.

9

ﬁ Time

ANALIMK

Date

Day key

Day of the month
Day of the week

Day of the year

Collapse ™



Use the columns under the Fields tab to create your report.

File Home Insert Modeling View Help Format Data / Drill Table tools
M L dkEdd (T
arm [
&l & [ o 7 L& ui[A] H | LR
Paste Get Excel Power Bl S5QL Enter Recent Transform Refresh New Text More New  Quick Publish
5 data~ datasets Server data socurces+ data~ visual box wisualsw measure measure
Clipbozrd Data Clugries nsert Calculations Share o~
Y .
ul < < Fields >
< Back to report ‘
Product line 2010 2011 2012 o2 | S A search
c
-
. - D o
Camping Equipment 332,986,338.00 402,757,573.17 500,382,422.583 35 g S v B Branch
Golf Equipment 153,553,850.98 168,006,427.07 230,110,270.55 17:| @ o
Mountaineering Equipment 107,099,659.94  161,039.823.26  14° g v [, Products
Cutdoor Protection 36,165,521.07 25,008,574.08 10,349,175.84 . b PPN R, Sales
Personal Accessories 391,647,082.61 456,323,355.90 594,000,408.42 44:
Total 914,352,803.72 1,159,195,590.16 1,495,891,100.90 1,117, O AAALINK
O X Gross profit
[J X Planned revenue
O X Product cost
< >
Page 1 of 1 Storage Mode: DirectQuery (click to change) Update available (click to download)




Cognos Parameterized Tables and Reports

You cannot use parameterized tables (mapped from Cognos parameterized query subjects) or

report mapped tables as regular tables. Power Bl will not be able to import them if you select any
parameterized tables or report tables:

Create connections

Loading blocked by failures with other queries.

| by failures with other queries.

Microsoft SQL: Query execution failed:

ading blocked by failures with other quenes.

When using parameterized query subjects in a Cognos report, or executing a pre-defined Cognos
report with prompts, users will be prompted to enter parameter values. But you cannot provide
parameter values in Power Bl for regular database tables.

The answer is to write custom SQL and use OpenTable and RunReport functions to feed
parameter values to Cognos.

Working with Parameterized Tables

The Analytics Connector supports working with parameterized tables in Power Bl by using the
OpenTable function, which lets you pass parameter values to Cognos.
Example:

select p."Product line", p."Product type", sum(s.Revenue) as Revenue,
sum (s.Quantity) as Qantity

from
OpenTable (
"Sales (query)"."Parameterized Products",
"p product line code"="[991, 992, 993, 994, 995]",
"p_Product Line"="'Golf Equipment'",
"p Date"="{d '2010-01-01"}",
"p Datetime"="'2010-01-01 19:00:00"'"

) as p



join "Sales (query)"."Sales" as s on (p.AAA LINK = s.AAA LINK)
group by p."Product line", p."Product type"

Instead of selecting from table directly, you use OpenTable function (a tabular function) to invoke
the parameterized table and join it to other tables. The first parameter "schema name"."table
name" iS the Cognos table name. This is followed by zero or more Cognos parameter name-value
pairs separated by commas. For more information, please refer to Function Syntax.

To begin, open Power Bl Desktop and select Get Data -> SQL Server from the ribbon. “SQL
Server database” dialog pops up.

In Server input box, Type in hostname of IP of Analytics Connector server.

In Database (optional) input box, type in database name given by your Analytics Connector
administrator when he/she mapped a Cognos package or data module to it. Please note, Database
is mendentary in this case.

Check DirectQuery and (optionally) check “Navigate using full hierarchy”.

Expend “Advanced options”, put custom SQL in “SQL Statement (optional, requires database)”
box.



Click OK.

SQL Server database

Server (i)

localhost

Database (opticnal)

GO Sales (query)

Data Connectivity mode (0
Q Import
® DirectQuery

4 Advanced options

Command timeout in minutes (optional)

50L statement (optional, requires database)

select p."Product line", p."Product type®, sum(s.Revenue)} &s Revenue, sum(s.Quantity) as Qant
from A
OpenTable (
"Sales ([query)"."Parameterized Products”,
"p_product line code"="[991, 992, 993, 994, 995]",

< >

¥ Include relationship columns

¥ Mavigate using full hierarchy
[ Enable SOL Server Failover support

x

A data preview window will display. Click Load.

localhost: GO Sales (query)

Product line Product type Revenue Qantity

Golf Equipment | Golf Accessories | 51514343 88 3115747
Golf Equipment | Irons 254814338 381445
Golf Equipment | Putters 1061584271.4 1284570
Golf Equipment | Woods 313898414 7 317939

Load TransformData| | Cancel |




You can now use the columns from the Fields tab to build the report.

Untitled - Power Bl Desktop

File Home Insert Modeling View Help
% |_—|?| Excel @ @ Transform data «
- Gt |j:‘@ Power Bl datasets [%g - [% Refresh

<¥ | dataw [P SQLServer

Clipbozrd Data Queries
T
ol N
< Back to report ‘
Product line Qantity  Revenue

Golf Equipment | 5113701 726,411,367.89

Golf Accessories | 3119747 51,514,343.88
Irons 391445 254814,337.99
Putters 1284570  106,184,271.37
Woods 317939 313,898,414.65
Total 5113701 726,411,367.89

Page 10of 1

Format Data / Drill
[[t‘r New visual f[‘]j]/]\
£
[ Text box d Publish
[I} More visuals
nsert Calculstions Share ~
W .
< < Fields »
= 2 search
<
@
n 5
5 E' o~ BB, Queryl
L =4
g > Product line
b Product type
¥ % Qantity
¥ 3 Revenue

Storage Mode: DirectQuery (click to change)



Working with Reports

The Analytics Connector supports working with Cognos reports in Power Bl by using the
RunReport function, which lets you pass parameter values to a Cognos report.

Analytics Connector only support list style Cognos reports, not crosstabs or charts.

Example:

Select *
From
RunReport (
"Connector Reports"."Parameter Report",
"p product line code"="[991,992,993,994,995]",
"p_Product Line"="'Golf Equipment'",
"p Date"="'2010-01-01"",
"p Datetime"="2010-02-01 19:00:00"
) as "Report"

The first parameter "schema name"."report name" is the Cognos report. This is followed by zero
or more Cognos parameter name-value pairs separated by commas. For more information of about
RunReport function, please refer to Function Syntax.

To begin, open Power Bl Desktop and select Get Data -> SQL Server from the ribbon. “SQL
Server database” dialog pops up.

In Server input box, Type in hostname of IP of Analytics Connector server.

In Database (optional) input box, type in database name given by your Analytics Connector
administrator when he/she mapped a Cognos package or data module to it. Please note, Database
is mendentary in this case.

Check DirectQuery and (optionally) check “Navigate using full hierarchy”.

Expend “Advanced options”, put custom SQL in “SQL Statement (optional, requires database)”
box.



Click OK.

SQL Server database

Server (i)
localhost
Database (opticnal)
GO Sales (query)

Data Connectivity mode (0
Q Import
® DirectQuery

4 Advanced options

Command timeout in minutes (optional)

50L statement (optional, requires database)

select *
From A
RunRepart {
"Connector Reports”."Parameter Report",
“p_product line code”="[991,992,993,994,595]", v
"p_Product Line"=""Golf Equipment"",

¥ Include relationship columns
O Navigate using full hierarchy
[ Enable SOL Server Failover support

A data preview window will display. Click Load.

localhost: GO Sales (query)

Product line code Product line Product type code Product type Year Revenue

595 Golf Equipment 868 | Irons 2010 46542811
995 Golf Equipment 969 | Woods 2010 5138304.03
595 Golf Equipment 970 | Putters 2010 2453044
995 Golf Equipment 971 | Golf Accessories 2010 854227.83

Load Transtom Datz | | cancel |




You can now use the columns from the Fields tab to build the report.

Untitled - Power Bl Deskiop

File Home Insert Modeling View Help
le |_—E'| Excel E @ Transform data ~
o G? ﬂn@ Power Bl datasets [&) - [% Refresh
¥ | cataw [E SQL Server
Clipboard Data Queries
T
Lt} N
< Back to report ‘

Product line 2010 Total

Golf Equipment | 13,115,856.96 13,115,856.96

Golf Accessories B864,227.83 864,227.83

Irans 463428110 4,654,281.10

Putters 2,459,044.00 2,459,044.00

Woods 5,138,304.03 5,138,304.03

Total 13,115,856.96 13,115,856.96

Page 1 of 1

Format Data / Drill
d:!.l New visual [5?‘
3
[ Text box & Publish
[DEF More visuals
nsert Calculations Share -
< < Fields %
= = | O Ssearch
1]
I s
7 N~ B Queryl
i 2 "
g‘ - Product line
n

[JZ Product line code
e Product type

[ E Product type code
¥ Z Revenue

X Year

Storage Mode: DirectQuery (click to change)



Working with Power Bl Parameters

In your Power Bl ODBC queries, you can replace the static values with Power Bl parameters to
create dynamic values that can be easily changed.

After configuring a Parameterized Table or Report query, click Edit Queries to bring up
2 the Power Query Editor.

Edit
Queries *

Click Manage Parameters to display the Parameters dialog.

Create a new parameter.

Parameters

New Name
FE Start Date x Start_Date
Description

Start date to pass to the parameterized table

¥ Required
Type
Date
Suggested Values

Any value

Current Value
1/1/2010

0K Cancel

Next, edit the query to include the parameter in the SQL statement. You may need to format non-
text data types using M language functions in order to append them to the statement.



The below example formats a date parameter to text and appends it to the SQL statement.

Queries [2] ] = Odbc.Query("dsn=Senturus Colo .45", "Select * From (#{1f)OpenTable(#(1f) ""Sales

(guery)"".""Parameterized Products"", #(1f) ""p_product line code""=""[991, 992, 993, 934, 995]"", #
(1f) ""p Product Line""=""'Golf Equipment'"",#(1f) ""p_Date""=""'" & Date.ToText(Start_Date, "yyyy-MM-

|A 2] dd") & """, #(1f) “"p_Datetime""=""'2018-81-81 19:02:80'""#(1f))#(1f)) as ""Parameterized Table""")l

8

NOTE: Double quotes must be escaped by using two sets of double quotes.

=X
ut Click Close & Apply.

Close &
Apply -

['/j [i, \&—II To change the Parameter value(s), select Edit Parameters under Edit

L

Edit | Refresh  New | Queries_
Queries = Page~ W

Edit Queries

H
t Data source settings

Edit Parameters

. m PR

Edit Variables

The Enter Parameters dialog will display with a list of configured parameters and their values.

Fill in new values and click OK.

Enter Parameters

Start_Date (0
12/31/2009

OK Cancel

Click Apply Changes if the data does not refresh.
Clipboard External data Insert
1 There are pending changes in your queries that haven't been applied. Apply changes

el Max Putter
el Fu

urze Pro Gloves



Function Syntax

Both OpenTable and RunReport functions adopt same syntax.
Syntax

Both OpenTable and RunReport function adopt following syntax:
OpenTable ( "Schema Name"."Table/Report Name"(, "Parameter"="value", ...) )

The first parameter is a table identifier, using standard SQL syntax. All identifiers are case
insensitive and the schema name can be omitted if the table name is unique cross schemas.

Any additional parameters are name-value pairs, separated by commas. Name and values
should be surrounded by double quotation marks.

Parameters

Use parameter name in place of "Parameter” for the Cognos connector.

Values
All values should follow SQL/ODBC standard.

Only plain string representation is allowed for numeric values. Formatted representations such
as 1,200.00 with thousand separators, (15) for -15, or 50% for .5 are not supported.

For string values, single quotation marks are used around the value. For example, 'Golf
Equipment’ or 'Sam"s Club'.

For date/time/timestamp values, use the ODBC standard format. For example {d '2010-01-01}
or ISO 8601 standard format, 'YYYY-MM-DD' for date, 'hh:mm:ss' for time and 'YYYY-MM-DD
hh:mm:ss' for timestamp.

An array of values is passed using brackets. For example:
e "product line code"="[991,992,993,994,995]"

The syntax for a Range parameters is represented by a 2 element array. For example:
e "YearRange"="[,2019]" — All years less than or equal to 2019
e "YearRange"="[2015,]" — All years greater than or equal to 2015
e "YearRange"="[2015,2019]" — Years between 2015 and 2019
Character escaping

Certain characters must be escaped.



For single quotes within a string value, use two single quotes to escape a single quote inside
the string.

Double quotes in parameter name and values need to be escaped with two double quotes.
Passing multiple values to a parameter

A Cognos parameter may accept multiple values, for example [Product line code] in
(?p_Product line code?). To specify multiple values in your function, put multiple values in a
pair of square brackets ([]) and separate each value by a comma (,) just like CSV format.



Publish to powerbi.com

After creating a Power Bl report, you can publish it to powerbi.com and share it with others. Simply
click on Publish button and select a destination you want to publish.

In order to allow powerbi.com access your on-premises data, you need to install and configure
Power Bl Gateway. If you use custom Data Connector in your Power Bl report, you need to install
Senturus Analytics Connector client on the computer where Power Bl Gateway is running and copy
custom connector file to it. For more information, please refer to Senturus Analytics Connector
Installation Guide.

To publish a Power BI report from Desktop to powerbi.com, follow steps below:

1.

SQL Server database

Server (i)
internal-bil
Database (opticnal)

GO Sales (analysis)

Data Connectivity mode ()
O Import

* DirectQuery

Senturus Analytics Connector

Server (1)
internal-bil
Port ()
5432

Database ()

GO Sales (analysi s)l

Data Connectivity mode (D)
O Import

* DirectQuery

OK

OK

Connect to Senturus Analytics Connector server using SQL Server database connection or
custom data connector.

Cancel

Cancel

Create your visualization, save Power Bl report, click Publish button.



3. Select a destination and click on Select.

Publish to Power Bl

Select a destination

Search

My workspace A
Cognos Report Insights

Intranet

MWD Senturus

Senturus Analytics for Salesforce

E SUERER S

o

4. Click on “Open ‘your report name.pbix’ Power BI” in the success dialog:

x
Publishing to Power Bl

v Success!

Open 'Sales (analysis).pbix' in Power B

. Did you know?
IIID

You can create a portrait view of your re
On the View tab, select Mobile Layout.

ored for mobile phones.

ieamn ':ncrg'

Got it

5. You will see an error if you did not setup a gateway using the same connection settings you
entered in step 1 before.

Sales (analysis)

[ File ~ — Export ~ |® Share Kfj ChatinTeams Q Getinsights

(9 There is no gateway to access the data source Extension. Show details

Home
¥ Favorites >
® Recent >
- Craate

B Datasets



6. Go to the workspace, hover over your mouse right to the newly created data set, and click on
“More options” button, then “Settings”:

AL_as_>UL Kerberos
Learn

Security
GO Sal /
zles (query) Rename
Workspaces ’
GO Sales (query) - SQL - Basic Auth sestings
My workspace e

Download the .pbix
GO Sales (query) data connector postgres

Manage permissions

RunReport View lineage
Al A, .
" Sales (analysis) O L5 : Dataset
Sales (query) Dataset

7. Click on the arrow button under Actions column and click on “Manually add to gateway”. If
you did add a data source using the same connection settings before, you will see a drop-
down list of data sources instead of “Manually add to gateway” button. In that case, you can
select a data source for your dataset without creating a new data source.

Settings for GO Sales (guery)

A\ One or more cloud data sources for this dataset have been deleted.
Recreate cloud data sources

Refresh history
»Dataset description

4 Gateway connection

To use a data gateway, make sure the computer is online and the data source is added in Manage Gateways. If you're using an On-premises data
gateway (standard mode), please select the corresponding data sources and then click apply.

lUse an On-premises or VMNet data gateway

Gateway Department Contact information Status Actions
@ bil.gateway xgao@senturus.com (%) Not configured correctly B -

Data sources included in this dataset:

Extension{"extensionDataScurceKind""SenturusAnalyticsConnector”,“exten
':?f:i‘ sionDataSourcePath™™{\"server\":\"internal-bil.senturus.com\"\"port\":\"54
32\ \"database\"\"GO Sales (query)\"}1"}

Manually add

to gateway

8. Now you can create a data source under a particular gateway.

If you are using SQL server connections in your report, you can create data sources just like
you do for other SQL server data source except that you have to pick Basic “Authentication



method”. Here is an example:

Data Source Settings  Users

Data Source Name

GO Sales (analysis)

Data Source Type

5QL Server A4

Server

internal-bi
Database

Sales (analysis)
Authentication Method

Basic v

The credentials are encrypted using the key stored on-premises on the gateway server. Learn more

Username

cognosembed@senturus.com

Password

[ skip Test Connection

>Advanced settings

Add Discard



If you are using custom data connector, you need to select “Senturus Analytics Connector”
from the Data Source Type list. Here is an example

Data Source Settings  Users

Data Source Name
GO 5ales (analysis)
Data Source Type
Senturus Analytics Connector v
Server
internal-bi1
Port
5432
Database
|Sa\es (analysis)
The credentials are encrypted using the key stored on-premises on the gateway server, Learn more
Username
cognosembed @santurus.com

Password

[ Skip Test Connection

»Advanced settings

Add Discard

Please note, you need to type in the exat server, port and database here as you have in
Power Bl Desktop (case sensitive). Please refer to step 1.



9. After creating data source, go back to data set settings, map the data source and click on
Apply.

Settings for Sales (analysis)

/N One or more cloud data sources for this dataset have been deletad,
Recreate cloud data sources

Refresh history

»Dataset description

4 Gateway connection

To use a data gateway, make sure the computer is online and the data scurce is added in Manage Gateways. If you're using an On-premises data
gateway (standard mode), please select the corresponding data sources and then click apply.

lUse an On-premises or Vet data gateway
[ ]

Gateway Department Contact information  Status

Actions

® (i bil.gateway xgao@senturus.com (@ Running on INTERNAL-BI1 82

K -

Data sources included in this dataset:

B Extension{"extensionDataSourceKind":"SenturusAnalyticsCo Maps to:
(“) nnector”,"extensionDataSourcePath":"{\"server\"\"internal-b |GO Sales (analysis) v
i1\ \"port\"\"5432\" \"database\"\"GO Sales (analysis}\"}"} i
Apply Discard

10. Finally, you can open your report and/or create new reports with your dataset.



CONTACT US

The latest version of the Analytics Connector along with related documentation and contact
information can be found at hitps://www.senturus.net/connector-download/.

If you have any additional questions, please contact us at CustomerSupport@senturus.com.



https://www.senturus.net/connector-download/
mailto:CustomerSupport@senturus.com
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